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The Print Shop provides a comprehensive suite of features and functionality to
create custom reports, forms and labels.  The Report Designer provides layout and
design tools to mimic required and / or regulatory forms and documents.
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1 Introduction

Welcome ... you are joining the worldwide community of users who have chosen the ultimate
animal information management system to keep track of their very important animal inventory
records.

This software product is the result of working with users in every strata of the animal world ... single
pet owners to fully operational zoological parks ... to develop the most comprehensive and feature
rich animal information management system.

Many of the features and functionality in aim cannot be found in other animal record keeping
products ... which is why aim has become the technology of choice for animal records management
around the world.

Please take a few minutes to familiarize yourself with the aim product ... run the software side-by-
side with this help system.

This Quick Reference Guide is a living document.  The most current version is always shipped on
the product CD and placed on the website downloads & updates  page.  Following the installation
of the software, you may want to periodically visit the website downloads & updates  page to see if
there is a newer version of this quick reference guide available for download.
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2 Getting Started

The aim Print Shop provides a robust set of features and functionality to design, print and export a
wide range of reports, forms and labels.

Report templates can be stored in the Report Explorer database, or stored directly to your computer's
file system.  The Report Explorer provides a secure repository for all of your report templates, and
direct access to the Report Designer.

2.1 The Basics

Report creation can be divided into four main activities:

            

When creating a report, these actions will be executed in the following order:

1. Select - Refers to the selection of data.  The report designer needs to know what data you want
to work with.

2. Design - Refers to creating a layout that describes how the document should look.

3. Process - Refers to the manipulation of the data in order to control the generation of the
document more precisely.

4. Generate - Refers to the creation of the actual document.

The Report Designer handles the Generate step for you, and with the help of this reference guide,
you will be able to master the Select, Design, and Process activities.

Select

Organized data is the first key to creating recyclable documents.  Here's an example:
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This table contains general care and maintenance information.  In database terms, each row of the
table is considered a record.  Each column of the table is considered a field.  When you are working
on the data selection, the goal is to create a table that will enable the report designer to generate your
document correctly.  Therefore, you will need to include all the fields you will need for the report, limit
the rows selected to only those which should appear in the report, and sort the rows so that they
appear in the correct order.

Design

Once data has been selected, you can begin designing your report.  You do this by creating a layout. 
A layout is a combination of objects that describe how the document should look.

This is the Report Designer.  As you can see, it looks like many of the other Windows applications
you're used to working with.  The big difference is that the Report Designer does not contain a
document; it contains a layout.  The layout can be used to generate many different documents, all
based on the data you've selected.
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The white rectangular areas with the gray bars below are called bands.  This report has a Title,
Header, Detail, and Footer band.

When a document is generated from this layout, the objects in the Title band will appear at the top of
the first page.  The Header band will appear at the top of each page.  The objects in the Footer band
will appear at bottom of each page.  And the objects in the Detail band will repeat down the page until
no more page space is available, at which point a new page will be started.  The Detail band prints
once for each row of your data selection.  This is how a document is created from the
layout.  You can generate a different document from the same layout by simply changing your data
selection.

Process

The Process activity of document creation allows you to provide additional instructions regarding how
the document should be created.  This includes, but is not limited to, sorting, searching and
performing calculations.  For example, you can combine
the First and Last Name fields of a contact so the data is easier to read in the report, or to calculate a
weighted average to appear in the summary section at the end of a report.

Most reports do not require a process, so don't worry about whether or not you can master this
activity.  This guide will show you how to do simple calculations, concatenation of data fields and
even some fairly complex stuff.

Generate

Generation is what happens when you click on the Preview tab in the Report Designer and see the
generated document in the print preview window.
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The document will either look right, or it won't.  If it doesn't look right, then it's time to return to the
Select, Design, or Process area and make the changes necessary to get the document generating
properly.  Sometimes you learn the most by tinkering with a data selection or layout and then
checking to see how the document is generated, via the Preview tab.

2.2 Report Explorer

The Report Explorer provides a secure repository to store all of your report templates, with the
flexibility to logically group report templates in meaningful ways.  The Report Explorer user interface
is similar to your computer's File Explorer, making it easy to understand and use.

Component Parts of the Report Explorer
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The Report Explorer interface gives you the
tools to add or remove folders to create the
desired repository for your report templates.

Select the New Report toolbar button or
menu item to launch the Report Designer.

To launch the Report Designer with an
existing report template, double-click the
desired report template name, or select the
desired report template and select the File |
Open menu item.

The toolbar provides one-click access to Report Explorer functionality.

Report Folders

Report folders provide a hierarchical structure to manage report templates.  The Report Explorer has
been initialized with a default configuration of folders and folder positions within the folder tree.

Add a new folder by selecting the New Folder toolbar button or menu item.  

Folders can be positioned using drag-n-drop with your mouse.  Click on the desired folder and drag it
to a new position in the hierarchical layout.

Report Templates

Report templates are saved to the Report Explorer from the Report
Designer, and appear in the assigned folder.

Report templates can be moved to a different folder using drag-n-drop.

An initial set of report templates are provided and have been placed into
Report Explorer folders.
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2.3 Report Designer

The Report Designer provides powerful, yet flexible and easy-to-use features and functionality to
design, preview and print reports, forms and labels.

Component Parts of the Report Designer

The above screen shot presents the full view of the Report Designer.  As you can see, there are a
number of parts to the user interface, which contribute to the design of each report template.

The following topics provide detailed information related to each functional area of the Report
Designer application.

Data Connections

Report Designer Workspace

Preview and Print

The Create a New Report topic provides an explanation of the steps and actions required to create a
new report template.

2.3.1 Data Connections

Data connections are created and modified on the Data tab.  Within the work environment of the
Data tab, end users can quickly create dataviews, which can then be used to supply data to reports. 
Dataviews are created via the Query Wizard or Query Designer.  

Both of these tools are visual; they also allow the end user to select the tables, fields, search criteria,
and sort order necessary for the report.  Behind the scenes, an SQL statement is generated and used
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to retrieve the data from the database.

2.3.2 Designer Workspace

The Report Designer workspace provides all of the tools that you need to construct the layout of your
reports, custom forms and labels.

Component Parts of the Designer Workspace

The toolbar provides a wide range of one-click actions to support the design of report templates. 
Refer to the Report Designer Toolbars topic for a detailed description of each toolbar.

Layout Editor

This section of the designer interface
displays the layout of the report template,
which includes:

§ Report Header and Footer

§ Title band

§ Detail band(s)

§ Summary band(s)

Layout Objects

This section of the designer interface
displays the objects contained in the report
template.

As objects, such as text labels, data fields
and images, are added to the report template
layout editor, they are listed in this pane.
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Layout Object Properties

This section of the designer interface
displays the properties for each object within
the report template.

When a layout object is selected in the
layout object pane (above), the properties for
the object are displayed in this pane.

Use this pane to customize the look and feel
of the layout object.

Data Tree and Data Fields

This section of the designer interface
displays the data tables that have  been
selected and connected for the report
template.

Additionally, the available data fields for each
data table are listed directly below the Data
Tree pane.

2.3.2.1 Layout Editor

The Layout Editor is the core workspace of the report designer.  It displays all report bands and the
objects positioned within each band.

The bands in the report can include:

§ Title - Information that appears at the top of the first page.

§ Header - Information that appears as a header for detail information.

§ Detail - Information for each record or line item in the report.

§ Footer - Information that appears at the bottom of the report page.

§ Summary - Information that appears at the end of a group or report.  Typically, this band is
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used to display calculated summaries.

Rulers are displayed at the top and left of the layout editor, which display the width and height of the
report, along with incremental indexes to assist positioning of objects.  By default, the indexes are
displayed in inches, but can be changed to other measurement units with the Report | Units menu
item.

The detail band is always visible, however, the visibility of the other bands can be set to add or
remove them from view.  To show or hide a report band, select the Report menu item and select or
unselect the menu item for that band.

Report objects can be manually placed into the Layout Editor, or automatically positioned when the
report is created using the Report Wizard.

2.3.2.2 Report Tree

You can display the Report Tree by selecting the View | Toolbars | Report Tree menu option.  The
report tree shows all of the bands and components in the report.  The components for each band are
listed in layered order (the order established via the Bring to Front and Send to Back commands). 
The bottommost component is listed first; the topmost component is listed last.

You can use the Report Tree to see exactly what components are contained in the report and to
select individual components.

You can turn on the Report Outline by right-clicking over the Report Tree.  The Report Outline is
useful when you have SubReports  in your report.  You can select any SubReport in the Report
Outline and the bands and components for that SubReport will appear in the Report Tree.  The
SubReport will also be displayed in the Report Designer.

The Report Tree, displayed at the left side of the form, also contains the Layout Objects pane and
the Layout Object Properties pane.

2.3.2.2.1  Layout Objects

The content of this pane displays a hierarchical list of objects within the Layout Editor workspace. 
The objects are logically grouped, according to their position with the report.

When you select an object in this pane, the associated object will be selected in the Layout
Editor and the object's properties will be displayed in the Layout Object Properties pane.

When an object is added to a report, in the Layout Editor, it will be automatically inserted into
this list.  By default, the objects in this list use a naming convention that describes the object
type, such as DBText1 when a data aware text object is added to the report layout.

The naming convention for each object can be modified to create a meaningful descriptor for
the object.  To change the name of an object, take the following steps:

1. Select the desired object in the Layout Objects list.

2. Click the right mouse button to display the popup menu and select the Rename menu
item.

3. Edit the text.
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2.3.2.2.2  Layout Object Properties

The Layout Object Properties pane displays the properties for each object in the Layout Editor.

To display the properties for an object, take the following steps:

1. Select the object within the Layout Editor, or Layout Objects pane.  Notice that the
properties for the object are displayed in this pane.

2. Set the desired properties for the object.

2.3.2.3 Data Tree and Data Fields

The Data Tree and Data Fields panes display the data pipelines and fields that have been connected
for this report.  Refer to the Data Connections topic for more information regarding data pipelines,
data tables and data fields.

You can display the data pipelines that can be used to create data-aware components within the
report by selecting the View | Toolbars | Data Tree menu option.  The data tree shows a list of data
pipelines in the top window and a list of fields for the currently selected data pipeline in the bottom
window.

You can select multiple fields in the field list and drag them into any band.  Data-aware components
and  corresponding labels will then be created.  Notice the Data and Layout tabs at the bottom of the
Data Tree.  You can use the Layout tab to customize the behavior of the Data Tree's drag-n-drop
capabilities.
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Data Tree - Data Tab

Any data tables that have been selected, via the Query Wizard or Query Designer on the Data tab, will
be displayed in this pane.

The available data fields for each data table will be displayed in the data fields pane, directly below
the Data Tree pane.

Data fields can be added to a report layout manually, using drag-n-drop or automatically, using the 
Report Wizard.

Data Tree - Layout Tab

The Layout tab of the Data Tree contains many settings which you can use to customize the
drag-n-drop capabilities of the Data Tree.

When a data field is added to the report layout, the components on this tab can be set to create:

§ The data field and a data field label.

§ The data field label only.

§ The data field only.

As you select an option, the image will demonstrate your selection.

All radio button
When selected, both DBText components (assigned to the selected fields) and corresponding label
components are created.

Label radio button
When selected, only Label components (with the captions set to the field name) are created.

Fields radio button
When selected, only DBText components (assigned to the selected fields) are created.

Style drop-down list
Controls whether the DBText and Label components are oriented in a columnar or stacked fashion.

Grid check boxes
Controls whether a shape is placed behind the DBText or Label component.  

Font icons
Controls the font name, size, style, and color via a standard font dialog.  Click the icon to display the
Font selection window.

Preview image
Shows how the created components will look.
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2.3.2.4 Designer Toolbars

The toolbars in the Report Designer provide one-click actions to perform numerous functions when
designing a report layout.

Select the View | Toolbars menu item to set or reset the visibility of a report designer toolbar.

Standard

The buttons on this toolbar perform standard actions, such as New, Open, Save, Print, etc.

Format

The buttons on this toolbar perform text formatting and object placement actions.

Standard Components

The buttons on this toolbar provide the means to add standard (non-data aware) objects to the report
layout.  From left-to-right, they are:

Select.  Places the cursor into select mode.

Label.  Used to display text.  Assign the Caption property to control the text value.  To resize the
label automatically so it fits a changing caption, set the AutoSize property to True.

Memo.  Used to print multiple lines of plain text in a report.  To set the value, assign a string list
to the Lines property.  To dynamically resize the memo during printing, set the Stretch property to
True.  Use the ShiftRelativeTo property to define dynamic relationships with other stretchable
objects.

Rich Text.  Used to print formatted text.  To set the value, assign the RichText property or use
the File | Open menu item in the popup text editor.  Use the ShiftRelativeTo property to define
dynamic relationships with other stretchable objects.

System Variable.  Used to display common report information such as page number, page
count, print date and time, date, time, etc.  The type of information displayed is controlled by the
VarType property.  The format is controlled by the DisplayFormat property.

Variable.  NOT SUPPORTED in this version of aim Print Shop.  In future versions of the print
shop technology, this component will support calculations via a report scripting language and
event handlers.

Image.  Used to display bitmaps and windows metafiles in reports.  Assign the Picture property of
this component in order to place an image in your report.  Use the Report Designer's built-in
picture dialog to load images at design-time.

Shape.  Use this component to print various shapes (squares, rectangles, circles, ellipses).  Set
the Shape property to select a type of shape.  Use the Brush and Pen properties to control the
color and border respectively.



Getting Started 16

© aim software group  -  all rights reserved

Line.  Use this component to place a line into the report band.

Bar Code and 2D Bar Code.  Used to render barcodes.  The string value assigned to the Data
property is encoded based on the BarCodeType.  If the data to be encoded is in a database, use
DBBarCode.  The following symbologies are supported: Codabar, Code 128, Code 39, EAN-13,
EAN-8, FIM A,B,C, Interleaved 2 of 5, Post-Net, UPC-A, UPC-E.

Data Components

The buttons on this toolbar provide the means to add data aware objects to the report layout.  A data
aware component displays data from the underlying data table.  From left-to-right, they are:

DB Text.  Used for displaying values from all types of database fields.  Use the DisplayFormat
property to format the value.

DB Memo.  Used to print plain text from a memo field of a database table.  This control will
automatically word-wrap the text.  Set the Stretch property to True and the component will
dynamically resize to print all of the text.  Use the ShiftRelativeTo property to define dynamic
relationships with other stretchable objects.

DB Rich Text.  Used to print formatted text from a memo or BLOB field of a database table.
This control will automatically word-wrap the text.  Set the Stretch property to True and the
component will dynamically resize to print all of the text.  Use the ShiftRelativeTo property to
define dynamic relationships with other stretchable objects.

DB Calc.  Used for simple database calculations (Sum, Min, Max, Count and Average).  The
value can be reset when a group breaks using the ResetGroup property.

DB Image.  Used to print bitmaps or windows metafiles, which are stored in a database BLOB
field.

DB Bar Code and DB 2D Bar Code.  Used to render barcodes based on the BarCodeType and
the value supplied via the DataField property.  The following symbologies are supported: 
Codabar, Code 128, Code 39, EAN-13, EAN-8, FIM A,B,C, Interleaved 2 of 5, PostNet, UPC-A,
UPC-E.

Advanced Components

The buttons on this toolbar provide the means to add advanced components to the report layout. 
From left-to-right, they are:

Region.  Used to logically group components and objects together.  Place a Region component
into the band and then place Standard or Data components into the Region.

Sub Report.  Used to handle multiple master details, create side-by-side reporting effects and
hook reports together as one.

Page Break.  Used to insert a hard page break within the report.
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Align or Space

The buttons on this toolbar provide the means to align or distribute objects in the report layout. 
These buttons are enabled when two or more report layout objects have been selected.

Size

The buttons on this toolbar provide the means to resize objects within the report layout.  These
buttons are enabled when two or more report layout objects have been selected.

Nudge

The buttons on this toolbar provide the means to incrementally move one or more report layout
objects.

Draw

The buttons on this toolbar provides the means to effect fill and line colors, widths and types.

2.3.3 Preview and Print

The Print Preview tab provides the tools preview and print a report layout.  As an example, the
following report layout ...

... which uses a JOIN between the aimMainItem and aimGeneralCare data tables, produces the
following display in the Print Preview pane.
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Notice that the Category column only displays Veterinary for one record.  This is because the
Suppress Repeated Values option was set on this report layout object.  If this option was
unchecked, then all rows in the report would display Veterinary.

In the next example, the report layout uses Sub Report layouts and Master-Detail links between the
aimMainItem, aimBirthActivities and aimBirthDetail data tables ...

    Master Record Layout

    Sub Report 1 - Layout for Birthing Activities linked to each Master Record
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    Sub Report 2 - Layout for Birthing Details linked to each Birthing Activity Record

... to produce the following Master-Detail report in the Preview pane.

When I select the Preview tab, the preview page is blank.  What happened?

A blank page will display if there is no data to support the preview.  This can happen for two reasons:

1. The Data Connections are not properly set.

2. The data table for the report does not have any data.

2.4 Report Viewer

The Report Viewer provides an easy to use interface to preview and print reports, forms and labels
that have been designed using the Print Shop Report Designer.
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Component Parts of the Report Viewer

The Report Viewer interface gives you the
tools to:

§ Select report templates stored in
the Print Shop database.

§ Select report templates stored on
your computer's file system.

§ Preview and Print selected report
templates.

Report Templates selected from the report
template lists are displayed in the report
viewer window on the right side of the
form.

Refer to the Report Viewer Toolbar
description ( below ), which describes how
to work with a displayed report.

Report Templates

Report templates contain all of the information needed to produce a user-designed reports, forms and
labels.  Templates can shared with other users, which adds significant flexibility to your reporting
experience.

Report Templates Lists

The report templates list displays reports that have been designed using the Report Designer and
saved to the Print Shop database or your computer's file system.

The report templates are listed in alphabetical order to make it easy to find the desired report.

To preview a report:

§ Double-click the desired report template name.

§ Select the desired report template name and click the report preview button on the report
viewer toolbar.
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Report Templates Tabs

Use the tabs at the bottom of the Report Templates panel to select the desired report templates
list.

Report Explorer Database.  This tab displays report templates that have been designed using
the Report Designer and saved to the Print Shop database.  The Report Explorer provides an
easy to use interface on top of the Print Shop database.

File System.  This tab displays report templates that have been designed using the Report
Designer and saved to your computer's file system.  Note that the Report Templates folder is the
default location for report templates saved to the file system.

Report Viewer Window

The Report Viewer window displays the selected report.

Refer to the Report Viewer Toolbar description ( below ), which
describes how to work with a displayed report.

Report Viewer Toolbar

The Report Viewer Toolbar provides one-click actions when previewing a selected report template.

From left-to-right, the toolbar buttons provide the following functionality.
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Select this toolbar button to display the selected report template in the report viewer window.

Select this toolbar button to print the report displayed in the report viewer window.

This group of toolbar buttons change the display of the report in the report viewer window.

This group of toolbar buttons provide report navigation for multi-page reports displayed in the report viewer
window.

Select this button to display the popup Search window.  In this example, we have constructed
an Auto Search on the Date field.  By looking at the rules, you can see that we want to set a
specific date range when Auto Search is used.  There are two (2) rules in this example:

1. Date is greater than or equal to Value

2. Date is less than or equal to Value

This type of search allows you to scope the range of records to be displayed ... such as all
records between 1/1/2008 and 12/31/2008.

Take the following steps for each Auto Search rule in the Search window:

1. Enter the value into the editor and uncheck the Show All checkbox.  

By removing the check mark in the checkbox, the value will be used to select the
desired records from the database.  To override the value and show all records for
this data field, simply place a check mark into the check box.

2. Repeat the above step for each Auto Search rule.

3. Click the OK button to close the window and perform the Auto Search.

Refer to Auto Search and Report Ranging (Reference Topics) for more details.
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3 Create a New Report

The aim Print Shop provides a robust set of features and functionality to create reports, custom
forms and labels.

To create a new report layout, take the following steps:

1. Select the View | Report Explorer menu item or the F2 keyboard key.  Notice that the Report
Explorer is displayed.

2. In the Report Explorer, select the File | New | Report menu item or the New Report toolbar
button.  Notice that the Report Designer is displayed.

3. Select the Data tab to set the Data Connection(s) for the report, form or label.

a. Select the File | New... menu item to display the New Items popup window.

b. In the New Items popup window, select the Query Wizard icon to launch the Query Wizard
, or the Query Designer icon to launch the Query Designer.  Typically, you should use the
Query Wizard to construct the initial dataview, and then use the Query Designer to refine
or modify the dataview attributes.

4. Select the Design tab to display the Layout Editor and take one of the following actions:

a. Construct the report layout manually

b. Select the File | New... menu item to display the New Items popup window.  In the New
Items popup window, select the Report Wizard icon to launch the Report Wizard.

5. Preview and Print the report, form or labels.

3.1 Select the Data Connections

Every report, form or label needs to access data from the database.  Data connections can be
accomplished using a manual or automatic approach.

Within the data workspace, you can select data from your database using an SQL query.  This
functionality is provided via query-based dataviews, which can be visually created using the Query
Wizard and visually maintained using the Query Designer.

The Query Wizard provides the tools to automatically select the desired data connections.

The Query Designer provides the tools to manually select the desired data connections or refine
dataview attributes for an existing query.

Regardless of which approach you choose, the resultant data connections will be displayed in the
Report Designer Data Tree and Data Fields panes.

3.1.1 Query Wizard

The Query Wizard will guide you through a sequence of steps to define the data connections for your
report, form or label template.  The majority of reports that you create, will use Steps 1 and 2 ... with
an occasional use of Steps 5 and 6.
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Step 1 - Select Data Table(s)

Select one or more data tables.  Each selected data table will be displayed in
the Selected Tables list.

Select the Next button to advance to the next Wizard step.

NOTE:  Selecting more than one table will create a JOIN between the tables.  This is a powerful
mechanism, but is not the same as a Master-Detail link.  As an example, you may want to JOIN the
aimMainItem and the aimGeneralCare data tables.  After you have selected the aimMainItem table
(demonstrated above) and then select the aimGeneralCare data table, the following popup window
will be displayed.

To JOIN the two tables, you need to specify the data fields to be used in the
join.  As demonstrated in the screen shot, the JOIN is accomplished with
the LinkID data field in the aimGeneralCare data table and the ItemID data
field in the aimMainItem data table.

NOTE: In all aim data tables, the LinkID data field contains the numeric
identifier of its master record in either the aimMainItem or aimContacts data
tables.  By joining the tables with ...

    aimGeneralCare.LinkID  =  aimMainItem.ItemID

...you are essentially saying, "Give me access to all records in the
aimMainItem data table that have a detail record in the aimGeneralCare data
table."

Select the OK button to close the popup window and return to the current
Wizard step.

Step 2 - Select Data Field(s)

At this Wizard step, take one of the following actions:
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1. Select the All Fields option to include all fields in the data table.

2. Select the Choose Fields option to manually select one or more data fields.

Following one of the above actions, select the Next button to advance to the next Wizard step.

Step 3 - Calculated Field(s)

At this Wizard step, take one of the following actions:

1. Select the No Calculations option to not use calculated fields.

2. Select the Add Calculations option to manually select one or more data fields.  As each data
field is selected, choose the type of calculation in the popup window - Sum, Count, Min, Max,
Average.

Generally, this step can be skipped for most report layouts.  Calculations can be integrated into your
report using the Variable toolbar component in the report designer.

Following one of the above actions, select the Next button to advance to the next Wizard step.

Step 4 - Group Rows

This step allows you to group rows together based on common field values.  Typically, grouping is
used to group a range of detail records into a higher level summary.

At this Wizard step, take one of the following actions:
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1. Select the No Grouping option to not group fields.

2. Select the Select Group Fields option to manually select one or more data fields.

Generally, this step can be skipped for most report layouts.

Following one of the above actions, select the Next button to advance to the next Wizard step.

Step 5 - Define the Search Criteria

This step allows you to set the search criteria, such as a Date Range or a specific set of animal
inventory items.

At this Wizard step, take one of the following actions:

1. Select the All Rows option to include all records in the data table.

2. Select the Define Search Criteria option to construct the desired search criteria ( data filter ).

To create a search criteria expression, click the right mouse button, within the Criteria window, and
select the desired menu item.  As an example, select the Insert Criteria option to display the
following popup window.

Use this popup editor to construct one or more statements in the search criteria.  To
construct a search criteria statement, take the following steps:

1. Select the desired data Field from the drop down list.

2. Select the desired Operator from the drop down list.

3. Enter the desired Value for the statement.

4. Select the OK button to close the popup window and display the statement in the
Criteria window in this Query Wizard step.

Following one of the above actions, select the Next button to advance to the next Wizard step.

Step 6 - Set the Sort Order
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This step allows you to set the sorting order for one or more data fields in the template.

At this Wizard step, take one of the following actions:

3. Select the Natural Order option to display the records using the data entry order.

4. Select the Set Order option to manually select one or more data fields.  The ascending or
descending attribute can be set for each data field chosen.

Following one of the above actions, select the Next button to advance to the next Wizard step.

Step 7 - Close the Query Wizard

This is the last step in the Query Wizard.

You can overwrite the default Name assigned to this query by entering a
meaningful name into the Name editor.

Click the Finish button to close the Query Wizard and display the
dataview on the Data tab.

3.1.2 Query Designer

The Query Designer provides the tools to manually construct a new dataview, or refine and modify
the attributes of an existing dataview.

The designer window provides a multi-tab user interface, with each tab representing a specific set of
attributes for the dataview.  They are:

§ Tables - Select one or more tables for the dataview.

§ Fields - Select one or more data fields for the dataview.

§ Calcs - Select data fields and construct calculation expressions.

§ Group - Select the data fields to be used in the grouping function.
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§ Search - Set the search criteria for the dataview.

§ Sort - Set the sort order for one or more data fields.

§ SQL - Displays the resultant SQL text for the dataview.

NOTE:  Typically, you will use the functionality on each tab to refine and modify the attributes of an
existing dataview.  However, you can directly modify the SQL text, but this will disable the
functionality on the other Query Designer tabs.

Recommendation: Use the functionality on each tab to modify or refine the attributes of a dataview,
and avoid modifying the SQL whenever possible.

To display the Query Designer, take the following steps:

1. Select the Data tab.

2. Select the File | New menu item.

3. Select the Query Designer icon in the popup window.

Tables

Dataviews are constructed using a single data table, or by joining or linking two or more data tables
together.

NOTE:  A JOIN is different from Master-Detail.

By joining two data tables, your dataview will contain data fields from each data table in a single dataview.

In a Master-Detail relationship, you will create two dataviews and link them together to create the Master-Detail relationship.

Double-click a data table name in the 
Available Tables pane to select one or more
data tables for this dataview.

Each selected data table will be displayed in
the Selected Tables pane.

The above screen shot demonstrates a single data table selection.  If this is the only data table that
you need, then you can move forward to the Fields tab and select the desired data fields to include in
the dataview.

Joining Two or More Data Tables
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You may have a requirement to join several data tables together for your report, such as joining the
animal inventory data table with the general care data table.  An example of joining two data tables
can be viewed using the General Care report template.

When you select a second, or subsequent, data table, the following popup window will display.

Use this popup window to select the data fields that will join the two data
tables together.

In the aim database, the following naming conventions are used to
uniquely identify each record:

ItemID - used in each data table to uniquely identify each record.

LinkID - used in detail data tables to hold the corresponding ItemID
from the Master data table.

To create the join, take the following steps:

1. Select the LinkID data field from the list on the left.

2. Select the ItemID data field from the list on the right.

3. Select the Add button to add the join to the Joined Fields list.  Notice
that the Operator is already set to create the join ... LinkID = ItemID.

4. Select the OK button to close the popup window.

By joining the two data tables, the Tables tab will now display the two selected tables and their join.

The above example joins the aimMainItem and aimGeneralCare
data tables.  When the report is generated from this dataview,
only animal inventory items that have general care records will be
displayed.

This type of join is very useful when you only want the report to
contain animal inventory items that also have records in a
selected detail data table.

This screen shot demonstrates two data
tables joined together.

The following image demonstrates the
dataview created from this join.

Linking Two or More Data Tables



Print Shop31

© aim software group  -  all rights reserved

You may have a requirement to link several data tables together to create a Master-Detail report,
such as linking the animal inventory data table with the birthing activities and birthing detail data 
tables.  An example of a Master-Detail dataview can be viewed using the Birthing Activity report
template.

To create the Master-Detail
dataview, take the following
steps:

1. Create a dataview for
each data table.

aimMainItem

aimBirthActivities

aimBirthDetails

2. Link the data tables
together.

a. Click the LinkID
field in the
aimBirthActivities
dataview.  Using
drag-n-drop, drag it
to the aimMainItem
dataview and drop it
on top of the ItemID
field name.  Notice
that a link line is
drawn between the
two dataviews.

b. Click the LinkID
field in the
aimBirthDetails
dataview.  Using
drag-n-drop, drag it
to the
aimBirthActivities
dataview and drop it
on top of the ItemID
field name.  Notice
that a link line is
drawn between the
two dataviews.

That's it! ... the linkages are in place to support a Master-Detail report template.  The following image
demonstrates the three dataviews linked together.

Fields
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The data fields that you select on this tab will
be displayed in the Data Tree pane and
available for use in the report layout editor.

To select data fields, take one of the following
actions:

§ Double-click the desired field(s). 
Notice that each data field will be
added to the Selected Fields list.

§ Select the All Fields check box to
include all data fields.

NOTE : To remove a data field from the
Selected Fields list, simply double click on
the desired data field name in the Selected
Fields list.

Calculations

Calculations can be performed on any data
field.  Several example are:

§ Count the number of records in the
report.

§ Sum the Amount Paid in a financial
report.

To create the calculation, perform the
following steps:

1. Double-click the desired data field
name.  Notice that the data field
appears in the Calculations pane.

2. Select the desired function from the
drop down Function list.

NOTE: If this is an Expression type
calculation, insert the arithmetic expression
into the Expression editor.

IMPORTANT NOTE:  Most of your
calculations can be performed with DBCalc
and Variable components in the Report
Designer...precluding the need to construct a
calculation within the Query Designer - Calc
tab.

Groups
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Grouping allows you to eliminate rows in the
report that have repeating values.

As an example the financial ledger data tables
contains financial information for animal
inventory and / or contact items.  Rather than
printing a row for each animal's or contact's
records, you can implement a group so that
the financial information can be summarized
at a higher level ... by animal or contact
identification information.

Search

The search tab functionality allows you to filter
the data that you want to include in the report.

As an example, you may want to limit your
report to only Horses, or Dogs, or Sheep, or
Cattle, etc.  To do this, perform the following
steps:

1. Double-click the desired data field
name.

2. Select the desired Operator for the
filter.

3. Enter the desired Value for the filter.

Repeat the above steps to include additional
data fields and search criteria.

Is this example you can see that the scope of
records will be restricted to Equine who also
have been tagged as Active in the database.

However, you may want more flexibility at
runtime to scope the range of data records in
meaningful ways ... such as a date range. 
This is referred to as Auto Searching and
Report Ranging.

To do this, use the auto search functionality on this Query Designer tab, which provides significant flexibility to your report usage. 
Refer to Auto Search and Report Ranging (Reference Topics) for more details.  

It is important to note that you can combine Search rules that do and do not use the auto search ... such as:

Field Operator Value AutoSearch Mandatory Show All
aimMainItem.BreedGroup Equals Equine FALSE FALSE FALSE
aimGeneralCare.Date Greater Than or Equal TRUE FALSE FALSE
aimGeneralCare.Date Less Than or Equal TRUE FALSE FALSE

At runtime, the report will be restricted to Equine only ... and the records will be scoped based on the date values that you enter into
the popup Search window.
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Sort

The sort tab functionality allows you to order
the display of data in the report, based on
data field values.

As an example, you may want to organize the
report to display your animal inventory items
based on the alphabetical order of the breed
group data field.  To do this, perform the
following steps:

1. Double-click the BreedGroup Field
Alias in the Available Fields pane.
Notice that the data field is displayed
in the Sort Fields pane.

2. By default, the sort will be ascending.
To reverse the order and display the
information in descending order,
place a check mark into the Desc (z >
a) column.

Repeat the above steps to include addition
data fields in the sort operation.

SQL

The resultant SQL statement for the dataview
query is displayed on the SQL tab.

Settings and declarations that you have made
on other Query Designer tabs is collated and
used to construct the SQL statement.

The SQL text can be directly edited ...
although, this is not recommended unless you
have experience working with SQL.  To edit
the SQL text, perform the following steps:

1. Click the right mouse button to
display the popup menu.

2. Select the Edit SQL menu item.
Notice that the edit window is enabled
and you can directly edit the SQL text.

3.2 Report Wizard

Once you have created the dataview, the next step is to create the report layout.  This can be done
manually, by individually dragging data fields onto the report bands of the layout editor ... or using the
Report Wizard ... which will construct the report layout automatically.

Step 1 - Select Data Fields
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Select one or more data fields.  Each selected data field will be displayed in
the Selected Fields list.

Select the Next button to advance to the next Wizard step.

Step 2 - Select Group(s)

Select one or more data fields to be used when grouping.

Select the Next button to advance to the next Wizard step.

Step 3 - Select Layout and Orientation

Select the desired Layout and Orientation attributes for this report layout.  To
make sure that the report layout fits all data fields within the page width,
place a check mark into the Adjust field widths... checkbox.

Select the Next button to advance to the next Wizard step.

Step 4 - Select the Report Style
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Select the desired style for this report layout.

Select the Next button to advance to the next Wizard step.

Step 5 - Close the Wizard and Create the Report Layout

This is the last step in the Wizard.  Select the desired option, Preview or
Modify, and then click the Finish button to close the wizard and construct
the report layout.

NOTE:  Each of the report templates, shipped with the aim product, were
constructed using this Wizard.

3.3 Preview and Print the Report

The Print Preview tab provides the tools preview and print a report layout.  The following screen shot
demonstrates a report layout displayed on the Preview tab.
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The toolbar buttons can be used to Print and size the displayed information, as well as navigate
through a multi-page report.

If you want to eMail the report to someone else, refer to the eMail Report as a PDF Attachment topic
for details.



Section

4Report Tutorials
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4 Report Tutorials

This section of the quick reference guide provides tutorial examples of the various report types that
can be designed with aim Print Shop.

4.1 Simple Banded Report

The aim Print Shop Report Designer gives you the features and functionality to design Band style
reports.  The available bands are:

Title - Contains information that is displayed at the top of the first page.

Header - Contains information that is displayed directly above the Detail band.

Detail - Contains information that is displayed for each record in the dataview.

Footer - Contains information that is displayed directly below the Detail band.

Summary - Contains information that is displayed at the end of the report.

The visibility of each band, except the Detail band, can be set via the Report Designer Report menu.
 The Detail band is always visible.

This topic will demonstrate how to design a simple banded report ... a list of records from the
Contacts (address book) data table.  The concepts presented in this topic provide a basic
understanding of banded report design and should be understood before moving on to design more
complex report layouts.

Open the Report Explorer and select the File | New Report toolbar button or menu item.  Notice that
the Report Designer is displayed.

When the Report Designer displays, select the Data tab.  With the Data tab displayed, select the File
| New... menu item to display the New Items popup window.

Double-click the Query Designer icon.  With the Query Designer window displayed, perform the
following tasks.

Task 1 - Select the Data

Select the Tables tab and double-click the aimContacts data table.  Notice that the aimContacts
data table is added to the Selected Tables list.
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Select the Fields tab and place a check mark into the All Fields checkbox.  Notice that all of the
data fields are displayed in the Selected Fields list.

Task 2 - Sort the Data

Click the Sort tab.

Double-click on AlphaName.

Click the OK button to close the Query Designer.  Notice that a dataview is displayed on the Data
tab.

Click the Preview toolbar button on the dataview.  Notice that the data is ordered by AlphaName
( LastName, FirstName ).

Click OK.

Task 3 - Configure the Report Layout

Select the Design tab.  Notice that the Report Designer workspace is displayed.

Select File | New... menu item to display the New Items popup window.

Double-click the Report Wizard icon to display the Report Wizard.  At this point, refer to the
Report Wizard topic for descriptions of each Wizard step.  For this example of a simple banded
report, take the following actions at each Report Wizard step:

Step 1  - Select the following data fields:

AlphaName

Company

PhoneOne

Email

Step 2 - Skip this step.

Step 3 - Select Tabular and Portrait options.

Step 4 - Select the desired style for the report.
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Step 5 - Click the Finish button to close the Report Wizard.
 

Task 4 - Refine the Report Layout

When the Report Wizard closed, in the previous task, the following report layout will be displayed
in the Layout Editor.

Notice that the Report Wizard did much of your work for you.  The report layout contains the
following bands:

§ Title - Contains the report title.

§ Header - Contains the column headers for each data column.

§ Detail - Contains the data-aware components to display information from the data table.

§ Footer - Contains typical footer information ... Date, Time and Page number.

You can save and use the report layout, as is, or make refinements to meet your personal taste. 
At a minimum, you will want to change the text of the report title, and make adjustments to the
width of the components in the Header and Detail bands.

Change the Report Title Text

Select the text component in the Title band.

In the Properties pane, change the Caption property to Contact List.

In the Properties pane, place a check mark into the AutoSize property.

Resize and Reposition Components in the Header and Detail Bands

Components can be resized one at a time, or as a group.  For this demonstration, we will
resize several components at a time.

1. In the Header band, select the AlphaName component.

2. Hold down the Shift keyboard key and select the AlphaName component in the Detail
band.  Notice that both components have been selected.

3. Hold down the Shift keyboard key and then hold down the Left Arrow keyboard key. 
Notice that the width of both components gets smaller.  Release the Left Arrow key
when you are satisfied with the width for this data field.

Repeat the above steps for Company, PhoneOne and Email ... as desired.  

NOTE:  Before you resize the Company, PhoneOne and Email components, you may want to
move these components to the left ... to position them closer to the AlphaName.  To do this,
select the components that you want to move, using the Shift-click method described in Step
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2.  With the desired components selected, hold down the Ctrl keyboard key and use the Left
Arrow keyboard key to move the components to the left.

The following screen shot displays the Layout Editor, with the above changes.

If you are satisfied with the layout, select the File | Save As ... menu item to save the report
template.

4.2 Report Using Joined Tables

Joined tables are different from Master - Detail.  By joining data tables, you are creating a single
dataview that contains all available data fields from two or more data tables.

In this tutorial, we will join two data tables to create a report template.

Open the Report Explorer and select the File | New Report toolbar button or menu item.  Notice that
the Report Designer is displayed.

When the Report Designer displays, select the Data tab.  With the Data tab displayed, select the File
| New... menu item to display the New Items popup window.

Double-click the Query Designer icon.  With the Query Designer window displayed, perform the
following tasks.

Task 1 - Select the Data

Select the Tables tab and double-click the aimMainItem data table.  Notice that the aimMainItem
data table is added to the Selected Tables list.

Select the Fields tab and place a check mark into the All Fields checkbox.  Notice that all of the
data fields are displayed in the Selected Fields list.



Print Shop43

© aim software group  -  all rights reserved

NOTE: If you do not need all of the data fields, then uncheck the All Fields checkbox and select
only the data fields that you want to have available to the report template.

Select the Tables tab and double-click the aimGeneral data table.  Notice that the Join Table
window is displayed.

Use this popup window to select the data fields that will join the two
data tables together.

In the aim database, the following naming conventions are used to
uniquely identify each record:

ItemID - used in each data table to uniquely identify each
record.

LinkID - used in detail data tables to hold the corresponding
ItemID from the Master data table.

To create the join, take the following steps:

1. Select the LinkID data field from the list on the left.

2. Select the ItemID data field from the list on the right.

3. Select the Add button to add the join to the Joined Fields list.
Notice that the Operator is already set to create the join ... LinkID
= ItemID.

4. Select the OK button to close the popup window.

By joining the two data tables, the Tables tab will now display the two selected tables and their
join.

Select the Fields tab and place a check mark into the All Fields checkbox.  Notice that all of the
data fields are displayed in the Selected Fields list.

NOTE: If you do not need all of the data fields, then uncheck the All Fields checkbox and select
only the data fields that you want to have available to the report template.

At this point, you should have a single dataview that contains the selected data fields from the
aimMainItem and aimGeneralCare data tables.

Task 2 - Configure the Report Layout

Select the Design tab.  Notice that the Report Designer workspace is displayed.

Select File | New... menu item to display the New Items popup window.

Double-click the Report Wizard icon to display the Report Wizard.  At this point, refer to the
Report Wizard topic for descriptions of each Wizard step.  For this example of a joined table
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report, take the following actions at each Report Wizard step:

Step 1  - Select the following data fields:

UserDefinedID  (This is an example.  You should select the data field that best
identifies the animal inventory item)

Date

LedgerAmount

Category

SubCategory

Memo

Step 2 - Skip this step.

Step 3 - Select Tabular and Portrait options.

Step 4 - Select the desired style for the report.

Step 5 - Click the Finish button to close the Report Wizard.
 

Task 3 - Refine the Report Layout

When the Report Wizard closed, in the previous task, the following report layout will be displayed
in the Layout Editor.

Modify the report title, text for data columns and data field properties to achieve the desired
result.

The following image demonstrates the refined report layout.
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That's It!  Select the Preview tab to view your report.

4.3 Master - Detail Reports

A Master - Detail report displays detail information for each master row of data.  As an example, you
may want to design a report that displays all general care and maintenance records for each animal
inventory item ... or you may want to design a report that displays all financial transaction records for
each contact (address book) item.  Each of these examples can be easily designed to produce a
Master - Detail report.

This tutorial demonstrates how to design a Master - Detail report with a page break for each animal
inventory item.

Open the Report Explorer and select the File | New Report toolbar button or menu item.  Notice that
the Report Designer is displayed.

When the Report Designer displays, select the Data tab.  With the Data tab displayed, select the File
| New... menu item to display the New Items popup window.

Double-click the Query Designer icon.  With the Query Designer window displayed, perform the
following tasks.

Task 1 - Select the Master Data

Select the Tables tab and double-click the aimMainItem data table.  Notice that the aimMainItem
data table is added to the Selected Tables list.

Select the Fields tab and place a check mark into the All Fields checkbox.  Notice that all of the
data fields are displayed in the Selected Fields list.

Select the OK button to close the Query Designer.  Notice that a dataview is constructed for this
data table and displayed on the Data tab.

Task 2 - Select the Detail Data

Select the File | New... menu item to display the New Items popup window.

Double-click the Query Designer icon.  With the Query Designer window displayed, perform the
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steps in this task.

Select the Tables tab and double-click the aimGeneralCare data table.  Notice that the
aimGeneralCare data table is added to the Selected Tables list.

Select the Fields tab and place a check mark into the All Fields checkbox.  Notice that all of the
data fields are displayed in the Selected Fields list.

Select the OK button to close the Query Designer.  Notice that a dataview is constructed for this
data table and displayed on the Data tab.

Task 3 - Link the Master and Detail Data

Connect the LinkID data field in the General Care dataview  to
the ItemID data field in the Main Item dataview.  To do this,
take the following steps:

1. Click on the LinkID data field.

2. Drag the LinkID data field to the Main Item dataview
and drop it onto the ItemID data field.  Notice that a
link line will be drawn between the two dataviews.

Task 4 - Add a Sub Report and Set the Data Pipeline Properties

Select the Design tab to display the report layout editor view.

Place a Sub Report component, from the Advanced Toolbar, into the detail band.

NOTE:  When you add the Sub Report, two tabs will be displayed at the bottom of the
workspace: Main and SubReport1.  There is a separate workspace for the main report and for
each Sub Report.  You can access the workspace for any given report by clicking on the tab.

Select the Main item in the Report Tree and set the DataPipeline to aim_Main_Item.

Select the SubReport1 component, then take the following steps:

1. Change the UserName property to GeneralCare.  Notice that the new user name text is
displayed in the Sub Report component, the Report Tree and on the tab at the bottom of
the report layout editor.

2. Set the DataPipeline property to aim_General_Care.

3. Set the Top property to 0.  Notice that the GeneralCare Sub Report component shifts
upward in the detail band and is aligned at the top of the detail band.
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4. Drag the detail band divider up until it is flush with the bottom of the Sub Report
component.

Task 5 - Create the Header Band Layout

NOTE: Some of the actions in this Task are optional, such as adding the Shape and Image
components to the Header Band.  They are demonstrated in this Task so that you can see the
range of possibilities when constructing your report layout.

Set the Height of the Header Band to 1.5 inches.

Place a Label in the upper left corner of the Header Band and set the following Text properties.

Caption General Care and Maintenance

Font Set the desired Font and Style properties.

Place an Image in the upper right corner of the Header Band and set the following properties.

Picture Click the picture button (...) and navigate / select the desired logo image for
this report.

Set additional properties to achieve the desired size and stretch appearance for the logo
image.  To resize the image and keep an attractive appearance, set the 
MaintainAspectRatio and Stretch properties.

Place a Shape component on the left side of the Header Band, below the report title Label
component.  Set the Shape  property to stRoundRect.  Notice that the shape changes from a
rectangle to a rounded rectangle.  Set the Width to three (3) inches.

Select aim_Main_Item in the Data Tree to display the list of data fields for the Main Item data
table.

Select one or more data fields and drag them onto the Shape component in the Header Band. 
The selected data fields should be the ones the identify the animal inventory item, such as 
UserDefinedID, RegName, RegNumber, etc.

Position the data fields within the Shape component.  Resize the Shape component and / or the
data fields to achieve the desired appearance.

Task 6 - Create a Group on the Unique Identifier Data Field

Select Report | Groups ... from the Report Designer main menu.  Notice that the Groups dialog
window is displayed.

Select the data field that you positioned into the Shape component in the previous step.  As an
example, if you placed the UserDefinedID data field into the Shape component, then select the
aim_Main_Item.UserDefinedID from the drop down list at the top of the dialog window.

Click the Add button to create the Group.  Notice that the data field name is displayed as

Group[0]: aim_Main_Item.UserDefinedID
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Click the Start New Page and Reset Page Number check boxes near the middle of the dialog. 
This will cause the listing for each animal to start on a new page and appear with its own page
numbers.

NOTE: Because groups are based on a change in field value, the field on which a group is based
should always be used to order the records.  Therefore, you must order the records by specifying
an Order By clause in an SQL query.  The Order By should be based on the data field of the
Group.

Click the OK button.  You should see two new bands: one above and one below the detail band. 
These bands have no height; thus, no white space appears above the dividers.

The following image demonstrates how the Master layout should appear when this task is
completed.

 

Task 7 - Create the Sub Report Layout

Select the aim_General_Care tab at the bottom of the report layout editor.  Notice that three (3)
bands are visible; Title, Detail and Summary.  We will place components into each of these
bands during this Task.

Select the File | New menu item to display the New Items popup window.

Double-click the Report Wizard icon.  Notice that the New Items window disappears and the
Report Wizard is displayed.
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Select the following data fields.

Date

LedgerAmount

Category

SubCategory

Memo

Each selected data field will be displayed in the Selected Fields list.

Select the Finish button to close the wizard and construct the Sub
Report layout.

The following image demonstrates how the Sub Report layout should appear.

Now, let's move and remove some of the components to create an attractive Sub Report layout.

1. Remove all components in the Summary band (Date, Time, Page Number and Horizontal
Line).

2. Remove the New Report label in the Header Band.

3. Select all components in the Header Band and move them up within the band.

4. Select the Horizontal Line in the Header Band and change the Height to 0.05.

5. Resize the Header Band so that it is flush with the bottom of the Horizontal Line.

In the Header Band, adjust the header text and font style, as desired.

In the Detail Band, make the following changes.

1. Select the SubCategory and Memo data fields.

2. Click the Shrink Height To Smallest toolbar button.  Notice that the Memo data field is
now the same height as the SubCategory data field.

3. Select the Memo data field and place a check into the Stretch property.  This will allow the
memo data to automatically expand vertically as needed, depending on the amount of
data in the field.

4. Resize the Detail Band so that it is flush with the bottom of the data fields in the band.

The following image demonstrates how the Sub Report should appear at this point in the Task.
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As you can see, we have cleaned up the Sub Report layout and made changes to give it the
desired layout and appearance.

In the Summary Band, make the following changes.

1. Select the Summary Band and change the Height to 1.  This is temporary.  We want to
give ourselves some room to work, then we will resize it for the final appearance.

2. Select a Line component and place it into the Summary Band, directly below the Amount
data field.  Change the Height to 0.05.

3. Select a DBCalc component and place it into the Summary Band, directly below the Line
component.  Click the Right Justify toolbar button.  Set the DataField property to
LedgerAmount.  Use the right mouse button popup menu to select the desired display
format for this component.

4. Select the Amount data field, the Line and DBCalc components (in that order) and click
the Align Left toolbar button.  This will align all three components along their left sides.

5. Click the Grow Width To Largest toolbar button.  This will change the widths so that all
three components are the same width as the Amount data field.

6. Resize the Summary Band so that it is flush with the bottom of the data field in the band.

The following image demonstrates how the Sub Report should appear at this point in the Task.

That's It!  Select the Preview tab to view your report.

4.4 Master - Detail - Detail Reports

This tutorial demonstrates how to design a Master - Detail - Detail report.  In this report, we will use
the following data tables:

Contacts (address book)

Financial Ledger Transactions

Financial Ledger Transaction Details
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The report layout, demonstrated in this topic, is available in your report templates folder or can be
downloaded from the website Report Templates Library.  The name of the template is Ledger
Report Using MasterDetailDetail Layout.rtm

Another possibility for designing a Master - Detail - Detail report is birthing activity records.  To do
this, use the tasks in this topic, but replace the above data tables with the following data tables:

Main Item  ( animal inventory items )

Birthing Activities

Birthing Detail

Open the Report Explorer and select the File | New Report toolbar button or menu item.  Notice that
the Report Designer is displayed.

When the Report Designer displays, select the Data tab.  With the Data tab displayed, select the File
| New... menu item to display the New Items popup window.

Double-click the Query Designer icon.  With the Query Designer window displayed, perform the
following tasks.

Task 1 - Select the Master Data

Select the Tables tab and double-click the aimContacts data table.  Notice that the aimContacts
data table is added to the Selected Tables list.

Select the Fields tab and place a check mark into the All Fields checkbox.  Notice that all of the
data fields are displayed in the Selected Fields list.

Select the OK button to close the Query Designer.  Notice that a dataview is constructed for this
data table and displayed on the Data tab.

Task 2 - Select the Detail Data

Select the File | New... menu item to display the New Items popup window.

Double-click the Query Designer icon.  With the Query Designer window displayed, perform the
steps in this task.

Select the Tables tab and double-click the aimLedger data table.  Notice that the aimLedger data
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table is added to the Selected Tables list.

Select the Fields tab and place a check mark into the All Fields checkbox.  Notice that all of the
data fields are displayed in the Selected Fields list.

Select the OK button to close the Query Designer.  Notice that a dataview is constructed for this
data table and displayed on the Data tab.

Task 2 - Select the Detail - Detail Data

Select the File | New... menu item to display the New Items popup window.

Double-click the Query Designer icon.  With the Query Designer window displayed, perform the
steps in this task.

Select the Tables tab and double-click the aimLedgerDetail data table.  Notice that the
aimLedgerDetail data table is added to the Selected Tables list.

Select the Fields tab and place a check mark into the All Fields checkbox.  Notice that all of the
data fields are displayed in the Selected Fields list.

Select the OK button to close the Query Designer.  Notice that a dataview is constructed for this
data table and displayed on the Data tab.

Task 4 - Link the Master and Detail Data

Connect the LinkID data field in the Ledger
dataview  to the ItemID data field in the
Contact Item dataview.  To do this, take the
following steps:

1. Click on the LinkID data field.

2. Drag the LinkID data field to the
Contact Item dataview and drop it
onto the ItemID data field.  Notice
that a link line will be drawn between
the two dataviews.

Connect the LinkID data field in the Ledger
Detail dataview  to the ItemID data field in the
Ledger dataview.  To do this, take the
following steps:

1. Click on the LinkID data field.

2. Drag the LinkID data field to the
Ledger dataview and drop it onto the 
ItemID data field.  Notice that a link
line will be drawn between the two
dataviews.

Task 5 - Add a Sub Report and Set the Data Pipeline Properties

Select the Design tab to display the report layout editor view.

Place a Sub Report component, from the Advanced Toolbar, into the detail band.
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NOTE:  When you add the Sub Report, two tabs will be displayed at the bottom of the
workspace: Main and SubReport1.  There is a separate workspace for the main report and for
each Sub Report.  You can access the workspace for any given report by clicking on the tab.

Select the Main item in the Report Tree and set the DataPipeline to aim_Contacts.

Select the SubReport1 component, then take the following steps:

1. Change the UserName property to Ledger.  Notice that the new user name text is
displayed in the Sub Report component, the Report Tree and on the tab at the bottom of
the report layout editor.

2. Set the DataPipeline property to aim_Ledger.

3. Set the Top property to 0.  Notice that the Ledger Sub Report component shifts upward in
the detail band and is aligned at the top of the detail band.

4. Drag the detail band divider up until it is flush with the bottom of the Sub Report
component.

Task 6 - Create the Header Band Layout

NOTE: Some of the actions in this Task are optional, such as adding the Shape and Image
components to the Header Band.  They are demonstrated in this Task so that you can see the
range of possibilities when constructing your report layout.

Set the Height of the Header Band to 1.5 inches.

Place a Label in the upper left corner of the Header Band and set the following Text properties.

Caption Financial Transactions Report

Font Set the desired Font and Style properties.

Place an Image in the upper right corner of the Header Band and set the following properties.

Picture Click the picture button (...) and navigate / select the desired logo image for
this report.

Set additional properties to achieve the desired size and stretch appearance for the logo
image.  To resize the image and keep an attractive appearance, set the 
MaintainAspectRatio and Stretch properties.

Place a Shape component on the left side of the Header Band, below the report title Label
component.  Set the Shape  property to stRoundRect.  Notice that the shape changes from a
rectangle to a rounded rectangle.  Set the Width to three (3) inches.

Select aim_Contacts in the Data Tree to display the list of data fields for the Contact Item data
table.

Select one or more data fields and drag them onto the Shape component in the Header Band. 
The selected data fields should be the ones the identify the contact item, such as Company,
DisplayName etc.

Position the data fields within the Shape component.  Resize the Shape component and / or the
data fields to achieve the desired appearance.
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Task 7 - Create a Group on the Unique Identifier Data Field

Select Report | Groups ... from the Report Designer main menu.  Notice that the Groups dialog
window is displayed.

Select one of the data fields that you positioned into the Shape component in the previous step. 
As an example, if you placed the Company or DisplayName data field into the Shape
component, then select the aim_Contacts.Company or aim_Contacts.DisplayName from the
drop down list at the top of the dialog window.

Click the Add button to create the Group.  Notice that the selected data field name is displayed
as

Group[0]: aim_Contacts.Company

or

Group[0]: aim_Contacts.DisplayName

Click the Start New Page and Reset Page Number check boxes near the middle of the dialog. 
This will cause the listing for each contact (address book) item to start on a new page and appear
with its own page numbers.

NOTE: Because groups are based on a change in field value, the field on which a group is based
should always be used to order the records.  Therefore, you must order the records by specifying
an Order By clause in an SQL query.  The Order By should be based on the data field of the
Group.

Click the OK button.  You should see two new bands: one above and one below the detail band. 
These bands have no height; thus, no white space appears above the dividers.

The following image demonstrates how the Master layout should appear when this task is
completed.

 

Task 8 - Create the Ledger Sub Report Layout

Select the aim_Ledger tab at the bottom of the report layout editor.  Notice that three (3) bands
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are visible; Title, Detail and Summary.  We will place components into each of these bands
during this Task.

Select the File | New menu item to display the New Items popup window.

Double-click the Report Wizard icon.  Notice that the New Items window disappears and the
Report Wizard is displayed.

Select the following data fields.

Date

LedgerAmount

LedgerAccount

LedgerSubAccount

LedgerMemo

Each selected data field will be displayed in the Selected Fields list.

Select the Finish button to close the wizard and construct the Sub
Report layout.

The following image demonstrates how the Ledger Sub Report layout should appear.

Now, let's move and remove some of the components to create an attractive Sub Report layout.

1. Remove all components in the Summary band (Date, Time, Page Number and Horizontal
Line).

2. Remove the New Report label in the Header Band.

3. Select all components in the Header Band and move them up within the band.

4. Select the Horizontal Line in the Header Band and change the Height to 0.05.

5. Resize the Header Band so that it is flush with the bottom of the Horizontal Line.

In the Header Band, adjust the header text and font style, as desired.

In the Detail Band, make the following changes.

1. Select the LedgerSubAccount and LedgerMemo data fields.

2. Click the Shrink Height To Smallest toolbar button.  Notice that the LedgerMemo data
field is now the same height as the LedgerSubAccount data field.

3. Select the LedgerMemo data field and place a check into the Stretch property.  This will
allow the memo data to automatically expand vertically as needed, depending on the
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amount of data in the field.

4. Resize the Detail Band so that the Height is 0.5.

Place a Sub Report component, from the Advanced Toolbar, into the detail band.

NOTE:  When you add the Sub Report, a third tab will be displayed at the bottom of the
workspace: SubReport2.

Select the SubReport2 component, then take the following steps:

1. Change the UserName property to LedgerDetail.  Notice that the new user name text is
displayed in the Sub Report component, the Report Tree and on the tab at the bottom of
the report layout editor.

2. Set the DataPipeline property to aim_Ledger_Detail.

3. Uncheck the ParentWidth property.

4. Set the Width property to 6.  Drag the SubReport component and position it below the
LedgerAccount data field.

5. Drag the detail band divider up until it is flush with the bottom of the Sub Report
component.

The following image demonstrates how the Ledger Sub Report should appear at this point in the
Task.

As you can see, we have:

§ Cleaned up the Ledger Sub Report layout and made changes to give it the desired layout
and appearance.

§ Added a SubReport component to be used to display the Ledger Detail information.

In the Summary Band, make the following changes.

1. Select the Summary Band and change the Height to 1.  This is temporary.  We want to
give ourselves some room to work, then we will resize it for the final appearance.

2. Select a Line component and place it into the Summary Band, directly below the Amount
data field.  Change the Height to 0.05.

3. Select a DBCalc component and place it into the Summary Band, directly below the Line
component.  Click the Right Justify toolbar button.  Set the DataField property to
LedgerAmount.  Use the right mouse button popup menu to select the desired display
format for this component.

4. Select the Amount data field, the Line and DBCalc components (in that order) and click
the Align Left toolbar button.  This will align all three components along their left sides.

5. Click the Grow Width To Largest toolbar button.  This will change the widths so that all
three components are the same width as the Amount data field.

6. Resize the Summary Band so that it is flush with the bottom of the data field in the band.
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The following image demonstrates how the Ledger Sub Report should appear at this point in the
Task.

Task 9 - Create the Ledger Detail Sub Report Layout

Select the aim_Ledger_Detail tab at the bottom of the report layout editor.  Notice that three (3)
bands are visible; Title, Detail and Summary.  We will place components into each of these
bands during this Task.

Select the File | New menu item to display the New Items popup window.

Double-click the Report Wizard icon.  Notice that the New Items window disappears and the
Report Wizard is displayed.

Select the following data fields.

LedgerDetailCategory

LedgerDetailSubCategory

LedgerAmount

TaxDeductible

LedgerMemo

Each selected data field will be displayed in the Selected Fields list.

Select the Finish button to close the wizard and construct the Sub
Report layout.

The following image demonstrates how the Ledger Sub Report layout should appear.
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Now, let's move and remove some of the components to create an attractive Sub Report layout.

1. Remove all components in the Summary band (Date, Time, Page Number and Horizontal
Line).

2. Remove the New Report label in the Header Band.

3. Select all components in the Header Band and move them up within the band.

4. Select the Horizontal Line in the Header Band and change the Height to 0.05.

5. Resize the Header Band so that it is flush with the bottom of the Horizontal Line.

In the Header Band, adjust the header text and font style, as desired.

In the Detail Band, make the following changes.

1. Select the TaxDeductible and LedgerMemo data fields.

2. Click the Shrink Height To Smallest toolbar button.  Notice that the LedgerMemo data
field is now the same height as the TaxDeductible data field.

3. Select the LedgerMemo data field and place a check into the Stretch property.  This will
allow the memo data to automatically expand vertically as needed, depending on the
amount of data in the field.

4. Resize the Detail Band so that it is flush with the bottom of the data fields in the band.

Select Report | Groups ... from the Report Designer main menu.  Notice that the Groups dialog
window is displayed.

Select aim_Ledger_Detail.ItemID from the drop down list at the top of the dialog window.

Click the Add button to create the Group.  Notice that the selected data field name is displayed
as

Group[0]: aim_Ledger_Detail.ItemID

Click the OK button.  You should see two new bands: one above and one below the detail band. 
These bands have no height; thus, no white space appears above the dividers.

The following image demonstrates how the Ledger Detail Sub Report should appear at this point
in the Task.

As you can see, we have cleaned up the Ledger Detail Sub Report layout and made changes to
give it the desired layout and appearance.

That's It!  You now have a Master - Detail - Detail report.  Select the Preview tab to view your report
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4.5 Interactive Previewing With Drill-Down

This tutorial builds on the Master - Detail - Detail report and demonstrates how to design a report with
interactive previewing functionality ... allowing you to drill down to view detail records of information.

The report layout, demonstrated in this topic, is available in your report templates folder or can be
downloaded from the website Report Templates Library.  The name of the template is Ledger
Report Using Detail Drill Down Layout.rtm

We will use the Ledger Report Using MasterDetailDetail Layout.rtm template to demonstrate drill
down techniques.

Task 1 - Load the Report Template

Open the Report Explorer and select the File | New Report toolbar button or menu item.  Notice
that the Report Designer is displayed.

When the Report Designer displays, select the File | Load From File ... menu item.

Navigate to the report templates folder and select the Ledger Report Using MasterDetailDetail
Layout.rtm file.

Task 2 - Add Drill Down Capabilities for the Ledger Detail Records

Select the aim_Ledger tab at the bottom of the report layout editor pane.

The following image demonstrates the aim_Ledger Sub Report layout.

Place a Shape component into the Detail band and set the following properties:

Brush | Color clWhite

Pen | Color clWhite

UserName DetailDrillDown

ParentWidth TRUE

Top 0

Click the right mouse button on the Shape component and select the Send To Back option from
the popup menu.  Notice that the Shape component is positioned behind the data fields.  The
following image demonstrates the aim_Ledger Sub Report layout with the Shape component
added and positioned.
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It's hard to tell the difference, but if you look closely you can see that the layout editor grid dots
cannot be seen in the line of data fields.  That's because the Shape component is behind the data
fields and covering the grid dots.

Click the right mouse button on the LedgerDetail: aim_Ledger_Detail Sub Report component
and select the Drill Down menu item.  Notice that the Drill Down Component popup window is
displayed.

Select DetailDrillDown from the drop down list and then click the OK button.

That's It!  Select the Preview tab to view your report.  When the report is displayed in the Preview
tab, click on any row in the report to see it expand (drill down) to display detail records.

4.6 Emulate a Regulatory or Existing Form

The aim Print Shop provides the features and functionality to create custom forms, WYSIWYG
single page forms, as well as forms that mimic existing documents.  This topic demonstrates how to
use a bitmap image in the background to mimic an existing document.  This technique can be used to
mimic any type of standard or regulatory document.

The techniques described in this tutorial can be used to create a report template for any type of
regulatory document.

Open the Report Explorer and select the File | New Report toolbar button or menu item.  Notice that
the Report Designer is displayed.

When the Report Designer displays, select the Data tab.  With the Data tab displayed, select the File
| New... menu item to display the New Items popup window.

Double-click the Query Designer icon.  With the Query Designer window displayed, perform the
following tasks.
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Task 1 - Select the Data

Typically, a regulatory document will need to display information from:

§ MainItem table (animal inventory items) - Forms that mimic USDA, AZA, etc. forms.

§ Contact table (address book) - Forms that mimic W-2, Tax, etc. forms.

Select the Tables tab and double-click the desired data table.  Notice that the selected data table
is added to the Selected Tables list.

Select the Fields tab and place a check mark into the All Fields checkbox.  Notice that all of the
data fields are displayed in the Selected Fields list.

Task 2 - Set Search Criteria for the Data

This is an optional step and should only be used if you want to limit the number of records to be
processed.

Click the Search tab.

Double-click on the desired data field.  Notice that the selected data field is moved to the lower
pane.

Select the desired Operator and Value for the search, such as:

Category  =  Staff  for contact items

BreedGroup  =  Equine  for animal inventory items

Click the OK button to close the Query Designer.

Task 3 - Configure Page Size and Bands

Select Report | Header from the Report Designer main menu.  The header band will be
removed.

Select Report | Footer from the Report Designer main menu.  The footer band will be removed.

Click the report selection icon located at the intersection of the horizontal and vertical rulers.  The
report will be selected in the Properties pane.

Expand the PrinterSetup property and set all of the margins (MarginTop, MarginBottom, etc.) to
zero.

Set the height of the detail band to 11.

Task 4 - Create an Image Component

Place an Image component on the left side of the detail band.

Configure the Image component:

Center False
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DirectDraw True

MaintainAspectRatio True

Stretch True

NOTE:  We want the image to be scaled because it's a little too big to fit on the page, despite the
zero margins.  We do not want to distort the form in any way, so MaintainAspectRatio has been
set to True.  Center is not needed because we want to print the form at a position of 0,0 (your
form image already contain white space around the edges).  Finally, the DirectDraw property will
force the image to be printed directly to the printer without utilizing an intermediate canvas, which
usually results in higher quality output.

Right-click over the Image component and select the Picture... menu option.

Navigate to find the WMF file that you want to use for this report template.

Set the image component position:

Left 0

Top 0

Width 7.8125

Height 10.9792

Task 5 - Position Data Fields onto the Form Image

Select the desired data field in the Data Tree and drag it onto the form.  Position the data field to
the appropriate location on the form.

Set the Font properties to ensure that the information in the data field will display correctly on the
form.

Repeat this task to position the required data fields.

That's It!  Select the Preview tab to view your report.

4.7 Custom Labels

This tutorial demonstrates how to print mailing labels via the Label Template Wizard, which is a tool
that creates report layouts suitable for printing on label sheets.  We will use Avery 5160 labels as the
model for this exercise.  Each label will include the following items:

§ A contact name

§ The company name for each contact

§ The mailing address for each contact
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Open the Report Explorer and select the File | New Report toolbar button or menu item.  Notice that
the Report Designer is displayed.

When the Report Designer displays, select the Data tab.  With the Data tab displayed, select the File
| New... menu item to display the New Items popup window.

Double-click the Query Designer icon.  With the Query Designer window displayed, perform the
following tasks.

Task 1 - Select the Data

Select the Tables tab and double-click the aimContacts data table.  Notice that the aimContacts
data table is added to the Selected Tables list.

Select the Fields tab and place a check mark into the All Fields checkbox.  Notice that all of the
data fields are displayed in the Selected Fields list.

Task 2 - Create a Calculated Field

Select the Calcs tab.

Double-click the City data field and notice that City(2) will appear as the first calculated field in
the Calculations list.

Click the new City(2) calculation.

Expand the drop down list in the Function column and select Expression from the list.  An edit
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box will appear in the Expression column.  Place your cursor into the edit box and enter the
following expression:

TRIM(City) + ', ' + TRIM(State) + '  ' + TRIM(Postal)

NOTE: The above expression concatenates the three data fields into a single text string and
trims each data field to ensure correct formatting.  The + symbol represents the
concatenation operator.  Concatenation is a process by which values are
combined into one result.  A typical result for this expression would be 'Jefferson, MD 
21755'.

Rename the City(2) field alias by clicking once on City(2), then waiting a second.  This will put
the field alias in edit mode.  Type CityStateZip in the edit box.

Task 3 - Sort the Data

Click the Sort tab.

Double-click on Postal.

Click the OK button to close the Query Designer.  Notice that a dataview is displayed on the Data
tab.

Click the Preview toolbar button on the dataview.

Scroll to the right until you see the Postal field.  Notice that the data is ordered by Postal ( the
companies with no Postal Code appear first ).  The last column should contain the combination of
the City, State, and Postal data fields, as specified in the calculated field we created.

Click OK.

Task 4 - Configure the Report Layout

Select the Design tab.  Notice that the Report Designer workspace is displayed.

Select File | New... menu item to display the New Items popup window.

Double-click the Label Templates icon to display the Label Templates popup window.
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On this popup window, select the Printer type and Label format, then click OK to close the
window and display the following layout editor.

Task 5 - Layout the Detail Band

Select the Shape object on the Standard Components toolbar and place it onto the Detail band
in the layout editor.

In the Properties pane, place a check mark into the ParentHeight and ParentWidth Layout
properties.  This will resize the shape to fill the Detail band.  Uncheck the Visible property.  We
do not want the shape to print, only the Contact information.

Place four (4) DBText components on the Detail band and align their left and vertical positions.

Select each DBText component and set the DataField and AutoSize properties.

DBText1 DataField = Company AutoSize = TRUE

DBText2 DataField = DisplayName AutoSize = TRUE

DBText3 DataField = AddrOne AutoSize = TRUE

DBText4 DataField = City_State_Postal AutoSize = TRUE

At this point, your label should look like the following.
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Select the Preview tab to review your label layout.

If satisfied, select the File | Save As ... menu item to save your Mail Label Template, otherwise,
adjust your layout and properties to achieve the desired results.

4.8 Form Letters With Mail Merge

Producing form letters, with mail merge capabilities, is easy with the aim Print Shop.  This topic
describes how to use the Form Letter Template to create your own form letters.

To create a custom form letter, take the following steps:

1. Launch the Report Explorer.

2. Navigate to the General Correspondence | Mail Merge Templates folder.

3. Double-click the Form Letter Template.  Notice that the Report Designer is displayed, with the
form letter template displayed in the Layout Editor.

4. Modify the form letter template with your own content and optionally, logo image.

5. Save the form letter template to a new name.

The following screen shot demonstrates the Layout Editor with the Form Letter Template displayed.

With the Form Letter Template displayed in the Layout Editor, we will want to perform the following
tasks:

1. Change or remove the Logo Image.

2. Change the content of the form letter.

3. Save the new form letter template to the Report Explorer template repository.

Task 1 - Change or Remove the Logo Image in the Form Letter

To remove the image from the template, select the image and use the Delete keyboard key to
remove the image.

To change the image in the template, perform the following actions:

1. Select the image in the template.
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2. Click the Picture property row.  Notice that a button appears in the row.

3. Click the button to display the file system navigation window.

4. Navigate your file system to locate and select the desired logo image.

Resize and reposition the image as desired.

Task 2 - Change the Content of the Form Letter

The form letter template, shipped with the aim Print Shop, is pre-formatted with the required
data fields to facilitate mail merge printing of Contact (address book) records.

To create your own form letter template, you will need to replace the text in the body of the form
letter.  To do this, perform the following actions:

1. Click the right mouse button in the form letter and select the Edit menu item.  Notice that a
popup text editor is displayed.

2. Replace the text in the body of the form letter with the desired replacement text.

3. Close the popup text editor.  Notice that your new text is visible in the Layout Editor.

Select the Preview tab to view the form letter as it will be printed.  If needed, repeat the above
steps to refine the text of your form letter.

When satisfied with your form letter, select the File | Save As... menu item to save your form
letter template.

4.9 Record Book With Cover Page

A Record Book is simply a grouping of existing reports with a cover page applied.  As an example,
you may already have report templates for Acquisition, Disposition, General Care and Ledger
information.  To construct a Record Book, you only need to create a title page and link each of the
Sub Reports into a single report template.

This tutorial will demonstrate how to link several reports together and construct a Title Page to create
a Record Book.

4.10 Breed Certificates and Pedigree Reports

Breed Certificates and Pedigree Reports are simply custom reports (usually one page) that include
user-defined levels of ancestry constructed in the aim Pedigree Workshop.

This topic will demonstrate how to design a simple breed certificate document.

Task 1 - Create the Pedigree Bitmap

Go to the Pedigree Workshop and navigate to the desired animal inventory item.

Select the desired number of generations to display.  For breed certificates, this number is
typically 3, but can be set to the desired number of generations that you want to print on your
breed certificate and / or pedigree report.

Use the display setting tools to show / hide outline borders for each item in the display.
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Use the display setting tools to show / hide the dotted line rectangle that surrounds the focused
item in the display.

Click the SaveAs toolbar button and select the Save to Database  ( Print Shop format ) menu
item.  The current pedigree display will be saved as a bitmap image to the database - accessible
within the Print Shop. 

Open the Report Explorer and select the File | New Report toolbar button or menu item.  Notice that
the Report Designer is displayed.

When the Report Designer displays, select the Data tab.  With the Data tab displayed, select the File
| New... menu item to display the New Items popup window.

Double-click the Query Designer icon.  With the Query Designer window displayed, perform the
following tasks.

Task 2 - Select the Data

Select the Tables tab and double-click the aimMainItem data table.  Notice that the aimMainItem
data table is added to the Selected Tables list.

Select the Fields tab and place a check mark into the All Fields checkbox.  Notice that all of the
data fields are displayed in the Selected Fields list.  This will provide you with the primary
information related to each animal inventory item as well as the pedigree image which was
created and saved in the Pedigree Workshop.

NOTE: If you are creating a breed certificate that needs to also display information that is stored
in a separate data table, refer to the Report Using Joined Tables topic for detailed information
about joining multiple data tables.

Task 3 - Configure Page Size and Bands

Select Report | Header from the Report Designer main menu.  The header band will be
removed.

Select Report | Footer from the Report Designer main menu.  The footer band will be removed.

Select File | Page Setup ... and set the page layout to Landscape.

Task 4 - Create an Image Component



Print Shop69

© aim software group  -  all rights reserved

Place a DB Image component on the detail band and position it at the desired location.

Configure the Image component:

Center True / False Choose whether you want the image to be
positioned using the center point of the image
component, or positioned at the top-left.

DirectDraw True DirectDraw property will force the image to be
printed directly to the printer without utilizing
an intermediate canvas, which usually results
in higher quality output.

MaintainAspectRatio True / False Set this option to TRUE if you want the image
to be scaled to fit within the outside boundaries
of the image component.

Stretch True / False Set this option to TRUE if you want to stretch
or shrink the image to fit within the outside
boundaries of the image component.

Task 5 - Place Database Fields and Text Components on the Page

Place the desired database fields and text components on the page.

Arrange the database fields and text components to meet your layout requirements.

Task 6 - Preview and Refine The Layout

The following screen shot demonstrates the Layout Editor with the Sample Breed Certificate
displayed.
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Repeat Steps 5 and 6 to achieve the desired results.



Section

5eMail Report as a PDF Attachment



eMail Report as a PDF Attachment 72

© aim software group  -  all rights reserved

5 eMail Report as a PDF Attachment

The aim Print Shop makes it easy to share your reports.  If you want to share the information in one
of your reports with someone else, the easy way is to send the report as an attachment to an eMail
message.

When a report is sent as an eMail attachment, the following actions will occur:

§ The report content will be converted into a PDF document.

§ The PDF document will be added to a blank eMail message.

All you need to do is write the eMail message and send it to the desired recipients.  When the
recipient(s) receive the eMail message, they can open and view the report attachment with a PDF
compatible viewer.

To send a report as an eMail attachment, perform the following steps:

1. Launch the Report Explorer.

2. Select the desired report template.

3. Select the eMail toolbar button or File | Email menu item.  Notice that this will display a blank
eMail message with the selected report template attached as a PDF document.
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6 Reference Topics

The topics in this section provide reference material related to components, layouts and and form
emulation.

Helpful Tips When Using the Designer

Smart Layouts

Smart Layout Examples

Sub Reports

Form Emulation

Auto Search and Report Ranging

6.1 Helpful Tips When Using the Designer

The Report Designer enables you to quickly and easily lay out complex reports.  The following tips
will help you achieve the best results when creating and / or modifying report layouts.

§ Maximize the Report Designer window and use the right mouse button speed menus as much as
possible.

§ To set display formats, make your dataview active and then use the speed menus to access the
Format dialog.  The Format dialog will determine the data type of the Data Field assigned to the
component and display several formats appropriate for that data type.  For example, a field of type 
date would provide a list of commonly used date formats.

§ To resize the bands using the mouse, position the mouse over the gray rectangular area below the
white space of the band, press the left mouse button, and drag.

§ To make a particular band appear as the selected object in the Properties pane, position your
mouse cursor anywhere over the open white space of the band (not over a component in the band)
and click the left mouse button.

§ To make the report appear as the selected object in the Properties pane, position your mouse in
the top left corner of the Report Designer's work area (to the left of the horizontal ruler and above

the vertical ruler) and click the Select Report icon .

§ You can cut, copy, and paste one or more report components at a time either in the same report or
between  different reports.

§ Use the PageLimit property of the report to limit the number of pages previewed when working on
long reports.  In other words, if the report is 200 pages long, set the PageLimit to 20 and only the
first pages will be previewed.

Dynamic Bands

Set the Band.PrintHeight property to phDynamic when you want the band to use page space on an
as-needed basis, shrinking or stretching to accommodate the report components.  When the
PrintHeight is set to phStatic, the band uses the exact amount of page space specified by the Height
property (unless it is not Visible, in which case it uses zero page space).
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Stretching Memos and Shapes

Set the Stretch property of a Memo when you want the Height of the memo to automatically stretch to
allow the entire contents of the memo to be printed.  If you are framing the memo with a Shape, set
the Shape.StretchWithParent property to True and the
Height of the shape will stretch to accommodate the height of the memo.  Finally, use the
ShiftWithParent property of the other report components to determine whether the position of the
report component should move as the memo stretches.

Controlling Component Visibility

You can use the BeforePrint event of a band to control which components appear when the band
prints.  To hide all the components in a band, set the Visible property of the band to False.  To hide
individual components, set the visible of each component to False.

6.2 Smart Layouts

Overview

The aim Print Shop allows you to create highly dynamic report layouts.  The SubReport, Memo,
RichText, and Region components have the ability to expand or contract to accommodate the
information they contain.  There are a host of properties designed to keep your reports looking good
in the variety of situations created by these dynamic components.

StretchWithParent

Allows a shape or line to expand or contract based on the change in height of the band or region in
which it is contained.

ShiftWithParent

Allows any non-stretching component to move up or down based on the change in height of the band
or region in which it is contained.

ShiftRelativeTo

Used to specify the vertical positioning that should take place between multiple stretching
components in a band.

StopPosition (for SubReports)

Used to set the position on the page where a childtype SubReport will stop printing.  Allows a
childtype SubReport to be confined to a rectangular area of the page.

BottomOffset

Used to create white space between multiple stretching objects that have been linked together using
the ShiftRelativeTo property.
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OverFlowOffset

Controls the position where a stretching component will begin printing when it overflows to additional
pages.  This property can be used to print an object at a different starting position when it overflows
onto additional pages.

ReprintOnOverFlow

Used to print non-stretching components when stretching components are printing on additional
pages.

6.2.1 Smart Layout Examples

One Memo in the Detail Band

               Design                               Preview

Here we have a single memo component in the detail band.  The memo's Stretch property has been
set to True. Each time the detail band prints, the height of the memo is recalculated based on the
amount of text it contains.  As a result, the memo may either grow or shrink in size and the detail
band will grow and shrink with it.  The memo may contain so much text that it cannot fit on a single
page.  In this case, the memo will print on additional pages until it is complete.  In the aim Print
Shop, this condition is referred to as overflow.  Both the memo and band components have a
boolean OverFlow property which can be checked while the report is generating to determine if the
memo is printing on an additional page.

One Memo with a Shape Background

               Design                               Preview

Here we have a single memo in the detail band with a shape behind it.  The shape has the
StretchWithParent property set to True.  The parent, in this case, is the detail band.  When the band
generates, the memo will stretch based on the text it contains; the band will resize to accommodate
the memo, and the shape will resize based on the change in height of the band.  This stretching and
resizing creates the effect of a border and background for the memo.  If the memo overflows onto
additional pages, we can also instruct the shape to print by setting the shape's ReprintOnOverFlow
property to True.
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One Memo with Label Beneath

               Design                               Preview

Here we have a single memo in the detail band with a label below it.  The label has the
ShiftWithParent property set to True.  The parent, in this case, is the detail band.  When the band
generates, the memo will stretch and the band will increase or decrease in height accordingly.  The
label will shift based on the change in height of the band.

Two Stacked Memos in the Detail Band

               Design                               Preview

This report requires two memos to be printed, one after the other.  This requirement is met by setting
the ShiftRelativeTo property of the second memo so that it points at the first.  With this configuration,
the first memo will print, stretching to accommodate the text it contains, and then the second memo
will print to completion.

Two Side-by-Side Memos with Labels Below
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               Design                               Preview

Here we have two memos in the detail band, each set to stretch.  When the report generates, the
band will grow or shrink to accommodate the memo that contains the most text.  Each memo has an
associated label below it.  We want the labels to shift in
relation to the memo above.  In order to accomplish this, we place the labels in a region and then set
the region's ShiftRelativeTo property to point at the memo above.  Now when the report is generated,
each label shifts in relation to the associated memo.

Child SubReports in Fixed Positions

               Design                               Preview

This report emulates a form that contains information in fixed rectangular areas of the page.  We can
get the report to 'fill out' this form by placing childtype SubReports at the beginning of each
rectangular area and setting the StopPosition property equal to the bottom of the rectangular area.

One Memo with Two Side-by-Side Memos Below

               Design                               Preview

In this report we have a single stretching memo that needs to print to completion, then two additional
memos need to print, starting immediately after the first.  We can achieve this effect by placing the
additional memos in a region and setting the region's ShiftRelativeTo property to the first memo.
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6.3 Sub Reports

Overview

In traditional banded-style report writers, reports that can be printed from a single source of data are
quite easy to create.  But if the content of the report consists of information from several different
sources of data, the choices become quite limited.  One option is to use SQL to join the data together
into one virtual table, and then build the report based on this table.  If many tables are involved,
the performance of this approach can be prohibitive.  Within aim Print Shop we can use free-form
SubReports to take advantage  of the many configurations available.

Single Data Table Used in Data Connection

A single data table can be connected directly to the report via the DataPipeline property.  When
printed, the report will generate one detail band for each record provided by the data table.

Master Dataset with Single Detail Data Table

In this scenario, the master data is connected to the detail data via a field or set of fields.  It is
assumed that this connection results in multiple detail records being selected for each individual
master record.  The master data is assigned to the report, and the detail data is assigned to a
SubReport.  When the report is generated, the main report will traverse all customer records and the
SubReport will traverse all orders for each customer.

Master Data with Nested Detail Data Tables
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Here we have the master dataset containing a list of customers.  Each customer has multiple orders;
each order has multiple products; and each product has multiple potential vendors.  This
configuration is called 'nested' because each set of records is
selected based on the linkage established with the previous dataset.  We can traverse this data
configuration by nesting
SubReports in the detail band.  The customer dataset is assigned to the main report.  The order
dataset is assigned to a SubReport in the detail band of the main report.  The product dataset is
assigned to a SubReport in the detail band of the product SubReport, and so on. In this way, the
report is constructed to match the data, and each dataset has a full layout that can be used to render
its contents.

Master Dataset with Multiple Independent Datasets

Here we have the order table.  Each order has many order items. For each order, there is also a
group of vendors that can supply the products for that order.  Both of these datasets are linked to the
master dataset, as opposed to being nested within one
another; therefore, the datasets are 'independent.'  This type of data can be handled by placing two
SubReports in the detail band. 

The first SubReport can be linked to the order item dataset, and the second SubReport can be linked
to the vendor dataset.  In order to print the vendor data after the order item data, we need to link the
vendor SubReport to the order item SubReport via the ShiftRelativeTo property.

Independent Datasets



Print Shop81

© aim software group  -  all rights reserved

Here we have three sources of data with no linkage between them.  In this report, we want to print all
of the customers, then all of the products, and then all of the vendors.  The report needs to fit
together like a book, with each dataset providing a chapter.  Here we use the main report to launch a
SubReport for each of the datasets.  The SubReports would be set with a PrintBehavior of section,
which means that each SubReport would start a new page, generate a set of pages as necessary to
traverse all of the data, and then return control to the main report.  The main report is not connected
to any dataset, and so will print only a single detail band.

6.4 Form Emulation

Overview

Form emulation is the process of taking a paper-based or electronic form and rendering a likeness of
it.  The likeness may include formatting of the form itself, or it may only contain the data that will
'fill-out' the form.  There are two basic issues that a form emulation solution must resolve:

1. How will the formatting of the form be generated?

2. How will the data that fills-out the form be generated?

The first issue is resolved by using either a page-sized band within the report or by utilizing a page
style.  A page style can be designed just like a band, but generate as a background to the bands of
the report.

The second issue is resolved by either using simple data-aware components or by using more
complex region or SubReport components.

In aim Print Shop, there are several approaches that can achieve form emulation.  These
approaches are discussed in detail in this section.

Single Page Forms
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            Design                                 Preview

Single page forms can be emulated in several ways:
1. Expand the detail band to the printable height of

the page, hide the header and footer bands, and
place all form formatting and data-aware controls
in the detail band.  This approach yields one form
per record. The following diagram shows an entire
form in the detail band.

2. Add a page style to the report.  Place all formatting
for the form in the page style.   Place the data
aware controls in the bands as you would when
building a normal report.  This approach yields a
variable number of records per form, depending on
the height of the bands.  In this approach, the
detail band is used to fill-out the form.  This
diagram shows how a detail band can fill-out a
page style.

3. Expand the detail band to the printable height of
the page. Hide the header and footer band, and
place all form formatting in the detail band.  Place
child-type SubReports in different areas of the
form where a table or particular source of data is
needed to fill-out that part of the form.  Place
data-aware components in areas of the form where
the main data pipeline supplies the data.  This
placement yields the most flexible and powerful
form emulation solution, but is only needed when
multiple datasets are used.  The following diagram
shows SubReports filling out a form in the detail
band.

            Design                                 Preview

This diagram shows SubReports filling out a form in
the detail band.

The form itself may be too complex to recreate using
report components.  In this case, it is recommended
that you scan the form and convert it to a Windows
metafile.  You can then place the windows metafile in
the report as a background for the detail band, or you
can place it in the page style, where it will function
naturally as a background for the report.

When you have a form in a WMF image, you get an
excellent print preview capability.  If you are printing
on pre-printed forms, you can set the visible property
to False when the report is sent to the printer.  In this
way you can provide a filled out form in the print
preview window, but only the text necessary to fill-out
the form is actually sent to the printer.

You can convert a scanned form to a Windows
metafile image (WMF) via a product such as
Transform Suite, by MIPS...or other commercially
available image conversion tools.
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Multi-Page Forms

            Design                                   Preview

All of the approaches discussed in the single
page form topic are applicable to multi-page
forms.  The additional problem of organizing
single-page forms into sets of multi-page forms
can be resolved using section style SubReports.

When section-style SubReports are rendered,
they generate a new page within the parent
report, continue generating pages until all data
has been traversed (or they are stopped
manually through a procedure call to the report
engine), and then return control to the parent
report.  One special behavior of section-type
SubReports is that the parent report generates
no pages when the section is placed in a
dynamic-height detail band. In this case, the
main report is used as a launching pad for
sections.  Since each section is a full-fledged
report in its own right, all of the single page form
approaches can apply to each section, thus
creating a multi-page form solution.

This diagram shows three section-type
SubReports in the detail band of the main report.
The main report is assigned to a data pipeline, so
the detail band will print once for each record. 
The SubReports contain data-aware controls that
point at this data pipeline.  This report provides
three pages of content for each record, and each
page has its own unique format.

6.5 Auto Search and Report Ranging

Auto Search and Report Ranging provides the ultimate flexibility when previewing and printing
reports, forms and labels.  This functionality is easy to understand and simple use.  This topic will
describe how to setup automatic searching when constructing a  report in the Report Designer ... and
how to use auto search and ranging when previewing and printing a report.

To Filter or Range a report based on a user-defined list, or by selecting existing data from a drop
down list, please refer to the Filtering Reports help topics.

Setup Auto Search in the Report Designer

With the Report Designer active, perform the following tasks to create Auto Search for your report.

Select the Query Designer Search Tab
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Select the Search toolbar button in the Data View window.  This will display the Query Designer,
opened to the Search tab.
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At the bottom of the Search tab, notice the section titled Criteria ... this is where you will setup the auto search for this report template.

In the above example, we have selected the Date field to set a date range on the report at runtime.  It is important to note that you can combine Search rules
that do and do not use the auto search ... such as:

Field Operator Value AutoSearch Mandatory Show All
aimMainItem.BreedGroup Equals Equine FALSE FALSE FALSE
aimGeneralCare.Date Greater Than or Equal TRUE FALSE FALSE
aimGeneralCare.Date Less Than or Equal TRUE FALSE FALSE

At runtime, the report will be restricted to Equine only ... and the records will be scoped based on the date values that you enter into the popup Search
window.

Take the following steps to add a data field to the search criteria of your report template:

1. Double-click the desired field name in the upper section of the Search tab.  Notice that the data field is displayed in the Criteria section.

2. For each data field added to the Criteria section, define the auto search settings:

§ Operator.  Select the desired operator.

§ Value.  Leave this blank for an auto search ... you will enter this value at runtime.

§ AutoSearch.  Place a check mark into this checkbox.  This denotes that this data field will be included in an auto search.

§ Mandatory.  Place a check mark into this checkbox if you want to force the user to enter a Value for this data field during a runtime auto search.

§ Show All.  This checkbox will appear at runtime.  When checked, ALL values in the data field will be displayed.  In other words, it will disregard
the Operator and Value settings.  When unchecked, the Operator and Value settings will be used during a runtime auto search.

3. Repeat the above steps for each data field that you would like to have available during a runtime auto search.

NOTE:  It is not important that you check / uncheck the Show All checkbox at this point.  The checkbox will appear during a runtime auto search and you can
set / reset the check mark at that time.

When you have completed adding data fields to the Criteria section, click the OK button at the bottom of the Query Designer to close this window.  Return to
the Design tab and use the Save, Save As and / or Save To File menu options to save your report template.

Working with Auto Search at Runtime

The Auto Search functionality is implemented in the Report Viewer or Report Explorer forms.

 In the Report Viewer, select the Report Filter and Range toolbar button to display the Search
window.
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 In the Report Explorer, select the Preview toolbar button
to display the Search window.
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In this example, we have constructed an Auto Search on the Date field.  By looking at the rules, you can see that we want to set a
specific date range when Auto Search is used.  There are two (2) rules in this example:

1. Date is greater than or equal to Value

2. Date is less than or equal to Value

This type of search allows you to scope the range of records to be displayed ... such as all records between 1/1/2008 and
12/31/2008.

Take the following steps for each Auto Search rule in the Search window:

1. Enter the value into the editor and uncheck the Show All checkbox.  

By removing the check mark in the checkbox, the value will be used to select the desired records from the database.  To
override the value and show all records for this data field, simply place a check mark into the check box.

2. Repeat the above step for each Auto Search rule.

3. Click the OK button to close the window and perform the Auto Search.

NOTE:  This same date range filter can be constructed using the "BETWEEN" operator.  To do this, take the following steps on the
Query Designer Search tab:

1. In the Criteria section of the Search tab, select the Date data field.

2. In the Criteria section of the Search tab, use the drop down list to select the BETWEEN operator.

3. Place a check mark into the Auto Search checkbox.

4. Click the OK button to save your changes and close the Query Designer.

5. Click on the Preview tab to display the report.

6. Click the Search toolbar button (magnifying glass) to display the Auto Search window.

7. Notice that the Date range rule allows you to enter a range of dates that lie between the two dates entered into the rule.

The below example demonstrates how the BETWEEN operator allows you to range a report with a single Auto Search Rule.
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6.6 Filtering Reports

By default, reports will be dynamically generated to include all records in the database.  This is
acceptable when you want to print a report that contains all animal records and / or detail records. 
However, there are occasions when you will want to limit a report to a specific group of animals or
even a single animal.  To do this, you will need to filter the report rules to allow a specific range of
records to be included in the generated report.  The following two topics provide instructions and
demonstrate the necessary steps to create a filtered report.

Filter Report With User-Defined Data List

Filter Report Using a Lookup of Existing Data

The primary difference between the two filtering approaches is that the User-Defined List allows you
to construct the list yourself, whereas the Lookup Selection list allows you to select specific items
based on existing data in the data base.

6.6.1 Filter Report With User-Defined Data List

A user-defined list allows you to enter specific data values that you want to use in filtering a report. 
The Auto Search dialog, with user-defined list functionality might look similar to the following screen
shot.

Notice that you have the flexibility to construct the items in the list.  These items will be used to filter
the report to display records for only the items in the list.

Example Usage

The primary usage for a user-defined filter list is to provide a mechanism to include one or more, but
not all, records in a report.  To override the user-defined list and include all records in the report,
simply place a check mark into the Show all values... checkbox directly below the list of items.

In the above example, the user has added three (3) Unique ID values to the list in order to limit (filter)
the report to only three (3) animals in the data base.  This same approach could be used to construct
a user-defined list for Breed Group, Breed Name, or any other data field.

The following steps demonstrate how to construct a user-defined list in the Auto Search dialog.
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Constructing a User-Defined Report Filter List

In this topic, we will use the existing General Care Report template and extend it to include a user-
defined report filter in the Auto Search dialog.

1. Select the View | Report Explorer menu item from the Print Shop main menu system.  Notice
that the Report Explorer is displayed.

2. Navigate to the Animal Inventory | General Care and Maintenance folder.

3. Select (double-click) the General Care Report.  Notice that the Report Designer is displayed.

4. Select the Data tab to display the aimMainItem Data View.

5. Select the Search icon (magnifying glass) at the top of the Data View.  Notice that the Query
Designer is displayed with the Search tab active.

6. In the Available Fields section, double-click the desired data field.  In this example, select the
UserDefinedID data field.  Notice that it is moved to the Criteria section at the bottom of the
Query Designer form.

7. In the Criteria section, click on the UserDefinedID data field and notice that the field name is
highlighted and interactive components appear to the right hand side of the data field name.

8. In the Operator column, select In List from the drop down selection list.  Leave the Value and
Parameter columns blank.

9. Select AutoSearch by placing a check mark into the AutoSearch checkbox.  Leave the
Mandatory and Show All checkboxes unchecked.

10.Click the OK button at the bottom of the Query Designer to close the form.

11.Select the Preview tab to display the General Care report.

12.Select the Search icon (magnifying glass) to display the Auto Search dialog.  Notice that the
Auto Search dialog displays the following rule:

That's it!  Add one or more Unique ID values to the filter list and then click the OK button on the Auto
Search dialog.  Notice that your report will only include general care and maintenance records for the
Unique ID values contained in the filter list.

Remember, this same approach can be used to construct additional filter lists for the Auto Search
dialog, such as Breed Group, Breed Name, etc.

NOTE:  The user-defined report filter rules (like the one above) will appear on the Auto Search dialog
when using the Print Shop Report Viewer.  This will allow you to preview and filter reports without
opening the Report Designer.
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6.6.2 Filter Report Using a Lookup of Existing Data

A data-defined lookup selection list allows you to select specific data values that you want to use in
filtering a report.  The Auto Search dialog, with data-defined lookup selection list functionality might
look similar to the following screen shot.

Notice that you have the flexibility to construct multiple lookup selection lists.  The selected item from
one or more of the lookup selection lists will be used to filter the report to display records for only the
items that have been selected.

Example Usage

The primary usage for a data-defined selection list is to provide a mechanism to limit the report to the
selected value for the report.  To override the data-defined selection list, simply place a check mark
into the Show all values... checkbox directly below the selection list of items.

In the above example, the user has a single Registration Number from the drop down selection list in
order to limit (filter) the report to only that animal in the data base.  This same approach could be
used to construct a data-defined selection list for Breed Group, Breed Name, or any other data field.

The following steps demonstrate how to construct a user-defined list in the Auto Search dialog.

Constructing a Data-Defined Report Filter Selection List

In this topic, we will use the existing General Care Report template and extend it to include three (3)
user-defined report filters in the Auto Search dialog.

1. Select the View | Report Explorer menu item from the Print Shop main menu system.  Notice
that the Report Explorer is displayed.

2. Navigate to the Animal Inventory | General Care and Maintenance folder.

3. Select (double-click) the General Care Report.  Notice that the Report Designer is displayed.

4. Select the Data tab to display the aimMainItem Data View.

5. Select the File | New menu item.  When the popup window is displayed, double-click the Query
Designer icon.  Notice that the Query Designer is displayed.
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6. Select the Tables tab to display the list a available data tables.

7. In the Available Tables section, double-click the aimMainItem data table name.  Notice that the
table name is displayed in the Selected Tables section at the bottom of the form and has been
renamed as aim_Main_Item.

8. Select the Fields tab and in the Field Alias column, double-click the BreedGroup, BreedName
and RegNumber data field names.  Notice that each of these data field names appear in the
Selected Fields section.

9. Click the OK button at the bottom of the Query Designer to close the form.

10.Select the Design tab to display the Report Designer.

11.In the top-left corner of the Report Designer, locate the Report Tree pane and take the
following actions:

a. Use your left mouse button and click on the Parameters node.  Notice that it is highlighted.

b. Use your right mouse button to click on the Parameters node and select the New popup
menu option.  Notice that a new parameter child node is created with the default name of
ppParameter highlighted and editable.  Enter a meaningful name for this parameter, such
as paramRegNumber.

c. Repeat steps a and b for the second and third parameters that we want to add to this
report (paramBreedGroup and paramBreedName).

Now that we have the Data Views and Parameters created, we can connect the parameters and data
views to create drop down selection lists to filter the report at runtime.

First, let's set the properties for each parameter.

1. In the Report Tree, click on the paramRegNumber parameter.  Notice that the properties pane
(directly below the Report Tree) displays the current properties for the parameter.  We want to
make the following changes:

a. In the Data properties section, expand the LookupSettings property by clicking the plus
sign (+) next to the LookupSettings property.

b. In the DataPipeline property, select aim_Main_Item from the drop down list.

c. In the Value Field property, select RegNumber from the drop down list.

d. In the User Interface section, expand the AutoSearchSettings property by clicking the plus
sign (+) next to the AutoSearchSettings property.

e. In the Enabled property, place a check mark into the check box.

Repeat the above steps for the paramBreedGroup and paramBreedName parameters, using
BreedGroup and BreedName when selecting the Value Field in step 1(c).

Now, with the properties set for each parameter, let's connect the parameters to the Data View.

1. Select the Data tab to display the aimMainItem and aim_Main_Item data views.

2. Select the Search icon (magnifying glass) at the top of the aimMainItem Data View.  Notice
that the Query Designer is displayed with the Search tab active.

3. In the Available Fields section, double-click the RegNumber, BreedGroup and BreedName
data fields.  Notice that the three data fields are moved to the Criteria section at the bottom of
the Query Designer form.

4. In the Criteria section, click on the RegNumber data field and notice that the field name is
highlighted and interactive components appear to the right hand side of the data field name.

5. In the Operator column, select the equals sign (=) from the drop down list.
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6. Leave the Value column blank.

7. In the Parameter column, select paramRegNumber from the drop down list.

8. Place a check mark into the Auto Search and Show All check boxes.

Repeat steps 4 - 8 for the BreedGroup and BreedName data fields, selecting paramBreedGroup for
the BreedGroup data field and paramBreedName for the BreedName data field ... then take the
following actions:

1. Click the OK button at the bottom of the Query Designer to close the form.

2. Select the Preview tab to display the General Care report.

3. Select the Search icon (magnifying glass) to display the Auto Search dialog.  Notice that the
Auto Search dialog displays the following rules:

That's it!  Select a specific value from one or more of the selection lists and then click the OK button
on the Auto Search dialog.  Notice that your report will only include general care and maintenance
records that conform to the selections that you have made.

Remember, this same approach can be used to construct additional selection lists for the Auto
Search dialog.

NOTE:  The data-defined selection list report filter rules (like the ones above) will appear on the Auto
Search dialog when using the Print Shop Report Viewer.  This will allow you to preview and filter
reports without opening the Report Designer.
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